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Paper Set 1 · 29 May 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
Akash is moving at 2 m/s inside the train, in the same direction as
the train's motion. Aditya is running outside the train in its direction
at 5m/s and if the speed of the train is 7.2 km/hr, find the speed of
Akash with respect to Aditya.

A.  1 m/s backward

B.  9 m/s backward

C.  6 m/s backward

D.  4 m/s backward

✓

Q2 Quant
After a flat discount of ₹135, a shirt is sold for ₹540. What is the
marked price of the shirt?

A.  ₹575

B.  ₹600

C.  ₹675

D.  ₹700

✓

Q3 Quant

A man travels 2 hours at a speed of 20 km/h, then 3 hours at a
speed of 25 km/h, and finally 1 hour at a speed of 30 km/h. He then
continues his journey at the same average speed as that of the
entire trip so far. How much time will he take to cover 290 km at this
average speed?

A.  10 hours

B.  11 hours

C.  12 hours

D.  13 hours

✓

Q4 Quant
The ratio of two numbers is 7 : 9, and their difference is 24. Find the
two numbers.

A.  56 and 72

B.  63 and 87

C.  48 and 72

D.  84 and 108

✓

Q5 Quant
Find the largest number that divides 80 and 111, leaving remainders
2 and 7, respectively.

A.  18

B.  26

C.  32

D.  38

✓

Q6 Quant
A number whose sixth part increased by 18 is equals to its fourth
part diminished by 12. Find the number.

A.  320

B.  340

C.  360

D.  380

✓

Q7 Quant
A class project requires 60 hours of work. If 5 students work
together and finish it in 3 days, how many hours per day did each
student work?

A.  4

B.  3

C.  5

D.  6

✓

Q8 Quant
If all weights in a weighted mean are equal, then the weighted
mean equals:

A.  harmonic mean

B.  unity

C.  zero

D.  arithmetic mean

✓

Q9 Quant
By how much is 30% of 65 greater than 30% of 45?309

A.  6

B.  1

C.  3

D.  8
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✓

Q10 Quant
A and B working together can do a piece of work in 4 days. B alone
can do the same work in 20 days. How long (in days) will A alone
take to do thrice the work?2552

A.  15

B.  30

C.  45

D.  60

✓

Q11 Quant
If the ratio of two numbers is 6 : 7, and their HCF is 46, then their
LCM is:

A.  1932

B.  1954

C.  1935

D.  1982

✓

Q12 Quant
A sum of ₹4,697 is divided into three parts such that half of the first
part, one-fourth of the second part, and one-eighth of the third part
are equal. What is the positive difference (in ₹) between the first and
the second parts?

A.  671

B.  521

C.  821

D.  721

✓

Q13 Quant
The difference between the simple interest and the compound
interest, compounded annually, on a certain sum of money for 2
years at 16% per annum is ₹750. Find the sum. (Round off your
answer to the nearest rupee)

A.  ₹29,297

B.  ₹29,288

C.  ₹29,293

D.  ₹29,277

✓

Q14 Quant
A sum of money is to be distributed among A, B, C, and D in the
ratio of 6 : 3 : 5 : 4. If A gets ₹2,000 more than D, then the share of C
is:

A.  ₹5,000

B.  ₹4,800

C.  ₹4,500

D.  ₹5,400

✓

Q15 Quant
In how much time (in months) will ₹3200 fetch an interest of ₹360 at
9% per year simple interest?

A.  15

B.  12

C.  13

D.  19

✓

Q16 Quant
A number when increased by 60%, gives 3380. The number is:

A.  2112.5

B.  2225.2

C.  1056.7

D.  1337.8

✓

Q17 Quant
An article is sold at a profit of 20%. If the cost of production goes up
by 10%, and the selling price is raised by 5%, what is the new profit
percentage? (Rounded to one decimal place)

A.  13.7%

B.  14.5%

C.  15.6%

D.  16.2%

✓

Q18 Quant
Suppose triangles ABC and DEF are similar. If the area of ΔABC = 36
cm2, area of ΔDEF = 81 cm2 and BC = 4.5 cm, find EF.

A.  3 cm

B.  4.15 cm

C.  5.5 cm

D.  6.75 cm
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✓

Q19 Quant

A.  1,386 cm2

B.  1,848 cm2

C.  2,310 cm2

D.  3,234 cm2

✓

Q20 Quant

A.  45

B.  90

C.  60

D.  120

GA

✓

Q21 GA
What did the Extremists believe was NOT a substitute for self-
government in India?

A.  Peaceful protests

B.  British military strength

C.  Good or just government

D.  Religious diversity

✓

Q22 GA
In which year was National Aluminium Company Limited (NALCO)
founded in Odisha?

A.  1971

B.  1989

C.  1978

D.  1981

✓

Q23 GA
What was the total outlay of Odisha's Annual Budget for FY 2025-26?

A.  ₹2,00,000 crore

B.  ₹2,50,000 crore

C.  ₹2,90,000 crore

D.  ₹3,00,000 crore

✓

Q24 GA
Which of the following best describes the process that creates
igneous rocks?

A.  Compression of small mineral grains over time

B.  Chemical reaction between water and rock minerals

C.  Solidification of molten material

D.  Transformation due to intense heat and pressure

✓

Q25 GA
Which type of plastid is responsible for photosynthesis in plant cells?

A.  Chromoplast

B.  Leucoplast

C.  Chloroplast

D.  Amyloplast

✓

Q26 GA
Which of the following is the primary cause of Global Warming?

A.  Increased use of renewable energy

B.  Deforestation and greenhouse gas emissions

C.  Depletion of ozone layer

D.  Changes in ocean currents
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Q27 GA
In October 2025, the 2025 UCI Track Cycling World Championships
took place in which country?

A.  Chile

B.  India

C.  Indonesia

D.  Sri Lanka

✓

Q28 GA
India successfully hosted the 12th World Para Athletics
Championships 2025 in New Delhi. What was significant about this
event for India?

A.  First time India won more than 30 medals

B.  First time India hosted the World Para Athletics
Championships

C.  Event was held at the Arun Jaitley Stadium

D.  Only male athletes participated

✓

Q29 GA
In which of the following Indian states was the Drone Kavach 2025
exercise conducted?

A.  Arunachal Pradesh

B.  Punjab

C.  Maharashtra

D.  Rajasthan

✓

Q30 GA
According to the Periodic Labour Force Survey (PLFS) monthly
estimates released in early 2026, what was the approximate
unemployment rate in India for January 2026?

A.  3.5%

B.  5.0%

C.  7.5%

D.  9.0%

✓

Q31 GA
Which place in Odisha was in news due to a rare “Hatiasundha”
(tornado-like formation) witnessed over its waters in October 2025?

A.  Ansupa Lake

B.  Chilika Lake

C.  Kanjia Lake

D.  Sorada Reservoir

✓

Q32 GA
Which of the following best describes the primary role of the
pressure gradient force in atmospheric dynamics?

A.  It governs the periodic rise and fall of oceanic tides due to
gravitational forces

B.  It initiates the horizontal movement of air from regions of
high pressure to low pressure

C.  It regulates the rotational velocity of the Earth and maintains
day–night cycles

D.  It triggers internal geodynamic processes such as volcanic
and seismic activity

✓

Q33 GA
The three great perennial river systems—Indus, Ganga, and
Brahmaputra—are primarily fed by which source?

A.  The melting of glaciers and snow in the high Himalayan
ranges.

B.  The heavy seasonal precipitation brought by monsoon
winds.

C.  The periodic rainfall patterns occurring during the winter.

D.  The discharge of water from vast underground aquifer
systems.

✓

Q34 GA
Which of the following Fundamental Duties was added to the
Constitution of India by the 86th Constitutional Amendment Act,
2002?

A.  To safeguard public property

B.  To promote harmony and brotherhood

C.  To protect and improve the natural environment

D.  To provide opportunities for education to children between 6
and 14 years

✓

Q35 GA
A train travels 60 km north in 1.5 hours and then 40 km south in 1
hour. What is the magnitude of its average velocity over the journey?

A.  40 km per hour

B.  16 km per hour

C.  24 km per hour

D.  8 km per hour
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Q36 GA
Which of the following Indian literary personalities is best known for
writing the novel Godan, which highlights the struggles of rural life?

A.  Rabindranath Tagore

B.  Premchand

C.  Bankim Chandra Chattopadhyay

D.  R. K. Narayan

✓

Q37 GA
Which of the following musical instruments is correctly classified as
a string instrument (Tat Vadya) in Indian classical music?

A.  Tabla

B.  Shehnai

C.  Sitar

D.  Mridangam

✓

Q38 GA
Which measure is commonly used to assess a country's level of
human development?

A.  Gross Domestic Product

B.  Per Capita Income

C.  Human Development Index

D.  Consumer Price Index

✓

Q39 GA
Which group significantly promoted Western education and cultural
reform in 19th-century Odisha?

A.  Persian scholars

B.  Tribal resistance leaders

C.  Mughal provincial governors

D.  Christian missionaries

✓

Q40 GA
Which of the following reactions is an example of a displacement
reaction?

A.  NaOH + HCl → NaCl + H₂O

B.  Fe + CuSO₄ → FeSO₄ + Cu

C.  2H₂ + O₂ → 2H₂O

D.  CaCO₃ → CaO + CO₂

English

✓

Q41 English
Choose the correct option to fill in the blank.

Lex is ______ student at Don Bosco, Calcutta.

A.  a

B.  an

C.  the

D.  no article required

✓

Q42 English
Select the option that can be used as a one-word substitute for the underlined group of words.

Mr. Gates’ highly impactful work on software shaped the field of computer science.

A.  conspicuous

B.  seminar

C.  seminal

D.  inconsequential

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q43 English
Choose the correct proverb to substitute the underlined word segment in the following sentence.

After being deceived in business once, Raghav now hesitates to trust new partners because he learned his lesson the hard way.

A.  was given a taste of his own medicine

B.  believed that every cloud has a silver lining

C.  was once bitten, and is now twice shy

D.  was caught between a rock and a hard place

✓

Q44 English
Choose the correct proverb to substitute the underlined word segment in the following sentence.

After hours of negotiation, both sides finally agreed that the proposal was reasonable and not worth arguing over.

A.  a bargain is a battle half won

B.  a friend in need is a friend indeed

C.  a fair offer is no cause of feud

D.  the customer is always right

✓

Q45 English
Select the correct passive voice form of the given sentence.

Someone had cleaned the room before we arrived.

A.  The room was being cleaned before we arrived.

B.  The room has been cleaned before we arrived.

C.  The room is cleaned before we arrived.

D.  The room had been cleaned before we arrived.

✓

Q46 English
Choose the correct form of future tense for the given sentence.

I exercised vigorously yesterday morning.

A.  I exercise vigorously every morning.

B.  I will exercise vigorously everyday from tomorrow.

C.  I had exercised vigorously yesterday morning.

D.  I am exercising vigorously now.
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Q47 English

Read the passage and answer the questions that follow.

On 11 July 1987, the global population touched the 5 billion mark. To spread awareness about population-related issues, the then-Governing
Council of the United Nations Development Programme in 1989 decided to observe 11 July as World Population Day. The day was first marked in
1990 across 90 countries. The number of people living in a particular city, town or country constitutes its population. By 2050, the world
population could be around 9.8 billion. However, we may reach the mark even earlier, due to the health-care crisis precipitated by the coronavirus
pandemic and the subsequent lockdown. With a population of 1.3 billion or 130 crore, India is the second most populous country in the world,
next to China. On World Population Day, this primer looks at the factors that affect population growth, the impact of COVID-19 crisis on
population control measures and why we need to fight population explosion, sooner than later.

Identify the suitable title for the passage.

A.  The Development of Urban Forests

B.  The History of International Trade

C.  The Growth of World Population

D.  The Expansion of Modern Technology

✓

Q48 English
Identify the central theme of the passage.

A.  Rise of global entertainment media

B.  Need for population control awareness

C.  Benefits of industrial expansion

D.  Decline of global healthcare systems

✓

Q49 English
What inference can be drawn from the passage?

A.  Education is unrelated to population growth

B.  Wildlife populations are increasing fast

C.  Technology alone solves population issues

D.  Population growth requires urgent attention

✓

Q50 English
What is the tone of the passage?

A.  Sarcastic and mocking

B.  Informative and cautionary

C.  Joyful and celebratory

D.  Romantic and emotional

✓

Q51 English
Choose the antonym of the word growth as used in the passage.

A.  Expansion

B.  Increase

C.  Progress

D.  Decline
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Q52 English
Select the most appropriate option to fill in the blank.
She completed her assignment ___, making sure there were no spelling or grammar mistakes.

A.  quickly

B.  slowly

C.  carefully

D.  loudly

✓

Q53 English
Read the following sentence and identify the option with the misspelt word.
The affordabiliity of hand phones has increased due to the prepaid system.

A.  affordabiliity

B.  increased

C.  system

D.  prepaid

✓

Q54 English
Select the most appropriate ANTONYM of the highlighted word.

The manager tried to diminish the team's concerns during the meeting.

A.  reduce

B.  amplify

C.  intervene

D.  decrease

✓

Q55 English
A statement is divided into different segments. The first segment (A) is fixed. Rearrange the remaining segments to make a meaningful
sentence.

A) active volcanoes
B) throwing hot ash
C) can erupt suddenly
D) during a massive explosion
E) into the atmosphere

A.  A B C E D

B.  A D E C B

C.  A C B E D

D.  A E C B D
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Q56 English
Choose the most appropriate antonym of the underlined word from the options given below.
The ruler was known for his despotic manner, allowing no room for dissent or opposition.

A.  tactful

B.  regal

C.  democratic

D.  autocratic

✓

Q57 English
Choose the option which converts the following into indirect speech.

"I must leave now, or I will miss the last train," said Arthur.

A.  Arthur said that he must leave then or he would miss the last train.

B.  Arthur said that he had to leave then or he would miss the last train.

C.  Arthur said that he had to leave now or he would miss the last train.

D.  Arthur said that he must have left then or he would have missed the last train.

✓

Q58 English
Select the option that can be used as a one-word substitute for the underlined group of words.

Called behavioural ecology, it starts from the idea or theory on which the explanation is based—that social and environmental forces select for
various behaviours that optimise people's fitness in a given environment.

A.  franchise

B.  archive

C.  premise

D.  promise
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Q59 English
Complete the sentence with the grammatically appropriate verb form.

The committee will ___ the proposal after thoroughly reviewing all the data.3938

A.  be finalize

B.  have finalize

C.  finalizes

D.  finalize

✓

Q60 English
Choose the correct option to form a meaningful sentence using the anchor segment, which is to be used at the end.
Anchor segment: as if he had never seen it before.

1. the magician
2. reacted
3. to his own trick
4. dramatically

A.  1 – 4 – 2 – 3

B.  2 – 1 – 4 – 3

C.  1 – 2 – 3 – 4

D.  4 – 1 – 2 – 3

Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''ମନ ____ ରହି ଲେ ସବୁ  କାର୍ଯ୍ୟ  ସଠି କ ରୂ ପରେ ସମ୍ପନ୍ନ ହୁ ଏ ।''

A.  ତରତର

B.  ଦୟାରେ

C.  ମନ୍ଦମନ୍ଦ

D.  ଶାନ୍ତି ରେ

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
The bowler delivered six perfect balls in the over.

A.  ବୋଲର ଏକ ଓଭରରେ ଉତ୍ତମ ଛ'ଟି  ବଲ ଫି ଙ୍ଗି ଥି ଲେ।

B.  ବୌଲର ଓଭର ଛଅ ବଲ ଫେଙ୍ଗି ଲେ।

C.  ବୌଲର ଓଭରରେ ସଠି କ ବଲ ଫେଙ୍ଗି ଛନ୍ତି ।

D.  ବୌଲର ଛଅଟି  ଓଭରରେ ବଲ ଫେଙ୍ଗି ଥି ଲେ।
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Q63 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ବି ପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ଶୁ ଖି ଲା

A.  କଞ୍ଚା

B.  ଆଦ୍ର

C.  ପତ୍ର

D.  ଗଛ

✓

Q64 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ମାନବ

A.  ମନୁ ଷ୍ୟ

B.  ପଶୁ

C.  ଦାନବ

D.  ଦୈ ତ୍ୟ

✓

Q65 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ତୁ ମ ଗାଁ  ର ପ୍ର ଥମ ସରପଞ୍ଚ କି ଏ ଥି ଲେ ?

A.  Who was the first Sarpanch of your village?

B.  Who are the first Sarpanch of your village?

C.  Who will be the first Sarpanch of your village?

D.  Who was the Sarpanch of your village?

✓

Q66 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ଗତ ମାସରେ, ଯେତେବେଳେ ଆମେ ହାଇଦ୍ରା ବାଦ ଯାଇଥି ଲୁ , ହଠାତ୍  ଆମର ଜଣେ ପି ଲାଦି ନର ବନ୍ଧୁ ଙ୍କୁ  ଭେଟି ଲୁ ।

A.  Last month, when we visited Hyderabad, we suddenly met one of childhood friends of ours.

B.  Last month, when we were visiting Hyderabad, we met one of our childhood friend.

C.  Last month, when we were visiting Hyderabad, we suddenly met one of my friends.

D.  Last month, when we were visiting Hyderabad, we met a friend .

✓

Q67 Odia
ଦି ଲୀପ ଭଲ ଖେଳୁ ଛି , କି ନ୍ତୁ ପଢୁ ନି ।ଏହି  ବାକ୍ୟରେ ଥି ବା ଅବ୍ୟୟ ପଦଟି କୁ  ଚି ହ୍ନଟ କର।

A.  ଦି ଲୀପ

B.  କି ନ୍ତୁ

C.  ଭଲ

D.  ଖେଳୁ ଛି
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✓

Q68 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  "ଦାତା" ଶଦ୍ଦର ବି ପରୀତ କି ଏ ?

A.  ଭୋକ୍ତା

B.  ଗ୍ରା ହ୍ୟ

C.  ଗ୍ର ହୀତବ୍ୟ

D.  ଗ୍ର ହୀତା

✓

Q69 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦକୁ  ପାଠ କରି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ବାଛ ।
ମାନବ ସମାଜ ଆଜି  ବି କାଶର ଚରମ ସୋପାନରେ ଉପନୀତ । ବି ଜ୍ଞାନର ଅବି ଶ୍ଵାସନୀୟ ଅଗ୍ର ଗତି  ଫଳରେ ମାନବ ସଭ୍ୟତା ଆଜି  ନୂ ତନ ଦି ଗକୁ  ଛୁ ଇଁ  ପାରି ଛି  । ନବ ସଭ୍ୟତା ଯେତେ ଯେତେ ଆଗକୁ
ଯାଉଛି  ଆମେ ସେତେ ସତେ ଆମ ପରମ୍ପରା ଓ ଐତି ହ୍ୟକୁ  ପାଶୋରି ବାରେ ଲାଗି ଛେ । ପ୍ରା ଚୁ ର୍ଯ୍ୟ ର ଆଲୋକ ଆମ ସାମ୍ନା ରେ ଏମି ତି  ଭେଳି କି  ଲଗାଇ ଦେଇଛି  ଯେ, ଆମ ଆଖ ପାଖର ମଣି ଷମାନଙ୍କୁ
ଆମେ ଏବେ ଅବହେଳା କରି ବାରେ ଲାଗି ଛେ । ତେଣୁ  ଏହି  ପ୍ର ବାଦଟି  ମନେ ପକାଇବା ଉଚି ତ ଯେ -'ଦୀପତଳ ଅନ୍ଧାର' । ଦୀପର ଧର୍ମ  ହେଉଛି  ଅନ୍ୟକୁ  ଆଲୋକ ପ୍ର ଦାନ କରି  ସମାଜର କଲ୍ୟାଣ
ସାଧନ କରି ବା । କି ନ୍ତୁ ପ୍ର ଦୀପର ଆଲୋକରେ ତା'ର ଚାରି ପାଖ ଆଲୋକି ତ ହେଉଥି ବା ବେଳେ ଏହାର ତଳ ପାଖ ଅନ୍ଧାରରେ ରହି ଥାଏ । ସେଥି ପାଇଁ  କୁ ହାଯାଇଛି -'ଦୀପତଳ ଅନ୍ଧାର' । ଏହି  ପ୍ର ବାଦଟି କୁ
ଆଲୋଚନା କଲେ ଜଣାଯାଏ ଯେ ସଭ୍ୟତାର ବି କାଶ ଚରମସୀମା ଛୁ ଇଁ ଥି ଲେ ହେଁ  ଅନ୍ଧବି ଶ୍ଵାସର ଚଉହଦି ରେ ଅନେକ ଛୋଟ ଛୋଟ ଜି ନି ଷ ଲୁ ଚି  ରହି  ସମାଜରେ ଅଶେଷ କ୍ଷତି  ଘଟାଇ ଥାଏ ।
ସେହି ପରି  ସମଗ୍ର  ବି ଶ୍ଵରେ ଯୁ କ୍ତରାଷ୍ଟ୍ର ଆମେରି କା ସବୁ  କ୍ଷେତ୍ର ରେ ଅଗ୍ର ଣୀ ହେଲେ ହେଁ  ସେଠାରେ ମଧ୍ୟ ଦୁ ର୍ନୀ ତି ,ଗରି ବୀ ଓ ବର୍ଣ୍ଣ ବୈ ଷମ୍ୟ ଭଳି  ସମସ୍ୟା ରହି ଛି  ଯାହା ବି ଶ୍ଵବ୍ୟାପୀ ଅପନି ନ୍ଦାର ଖୋରାକ
ଯୋଗାଇଥାଏ ଏବଂ 'ଦୀପତଳ ଅନ୍ଧାର' ଭଳି  ଲାଗେ ।

ଏହି  ଅନୁ ଚ୍ଛେଦରେ 'ବି କାଶର ଚରମ ସୋପାନ' ବାକ୍ୟର ସବୁ ଠାରୁ  ଉପଯୁ କ୍ତ ଅର୍ଥ  କଣ ?

A.  ଆରମ୍ଭ ଅବସ୍ଥା

B.  ସାଧାରଣ ଅବସ୍ଥା

C.  ଅବନତି ର ଅବସ୍ଥା

D.  ସର୍ବୋ ଚ୍ଚ ଉନ୍ନତି  ସ୍ଥର

✓

Q70 Odia
ଏହି  ଅନୁ ଚ୍ଛେଦରେ 'ପରମ୍ପରା ଓ ଐତି ହ୍ୟକୁ  ପାଶୋରି ବା'ର ଅର୍ଥ  କଣ ?

A.  ସମ୍ମାନ କରି ବା

B.  ରକ୍ଷା କରି ବା

C.  ଅବହେଳା କରି ବା

D.  ପ୍ର ଚାର କରି ବା

✓

Q71 Odia
ଏହି  ଅନୁ ଚ୍ଛେଦରେ 'ଦୀପତଳ ଅନ୍ଧାର' ପ୍ର ବାଦଟି  କେଉଁ  ପରି ସ୍ଥି ତି କୁ  ବୁ ଝାଏ ?

A.  ସମସ୍ତେ ଖୁ ସି  ଥି ବା ଅବସ୍ଥା

B.  ନି କଟର ଅସୁ ବି ଧାକୁ  ଅଣଦେଖା କରି ବା

C.  ଦୂ ରରେ ଥି ବା ଘଟଣାକୁ  ଦେଖି ବା

D.  ସମସ୍ତଙ୍କୁ  ସାହାଯ୍ୟ କରି ବା

✓

Q72 Odia
ଏହି  ଅନୁ ଚ୍ଛେଦରେ 'ବର୍ଣ୍ଣ ବୈ ଷ୍ଣବ' ଶଦ୍ଦଟି  କାହାକୁ  ସୁ ଚାଏ ?

A.  ଶି କ୍ଷାର ଅଭାବ

B.  ଧନ-ସମ୍ପତ୍ତି ର ଅଭାବ

C.  ଚର୍ମ ରଙ୍ଗ ଆଧାରି ତ ଭେଦଭାବ

D.  ଭାଷାର ପାର୍ଥ କ୍ୟ
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✓

Q73 Odia
ଏହି  ଅନୁ ଚ୍ଛେଦରେ 'ବି ଜ୍ଞାନର ଅଗ୍ର ଗତି ' ବାସ୍ତବ ଜୀବନରେ କଣ ସୁ ଚାଏ ?

A.  ନୂ ତନ ସଂସ୍କୃତି  ଗଢି ବା

B.  ଅନ୍ଧବି ଶ୍ଵାସ ବଢି ବା

C.  ପରମ୍ପରାର ନାଶ

D.  ମାନବ ସଭ୍ୟତାର ଉନ୍ନତି

✓

Q74 Odia
ଜ୍ଞାନୀ ଲୋକ ସମ୍ମାନ ଲାଭ କରନ୍ତି  । ଏହି  ବାକ୍ୟରେ 'ଜ୍ଞାନୀ' କେଉଁ  ପ୍ର କାରର ବି ଶେଷଣ ?

A.  ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  ପରି ମାଣବାଚକ ବି ଶେଷଣ

C.  ସଂଖ୍ୟାବାଚକ ବି ଶେଷଣ

D.  ସୂ ଚନାବାଚକ ବି ଶେଷଣ

✓

Q75 Odia
"ସେ କାର୍ଯ୍ୟ ରେ ଆବଶ୍ୟକୀୟ ସାମଗ୍ରୀ  ଆଣ" ଏହି  ବାକ୍ୟର ଶୁ ଦ୍ଧ ରୂ ପ କଣ ହେବ?

A.  ସେ କାର୍ଯ୍ୟ ରେ ଆବଶ୍ୟକ ସାମଗ୍ରୀ  ଆଣ ।

B.  ସେ କାର୍ଯ୍ୟ ରେ ଆବଶ୍ୟକୀୟା ସାମଗ୍ରୀ  ଆଣ ।

C.  ସେ କାର୍ଯ୍ୟ ରେ ଆବଶ୍ୟକତା ସାମଗ୍ରୀ  ଆଣ ।

D.  କୌଣସି ଟି  ନୁ ହେଁ  ।

Computer

✓

Q76 Computer
In Microsoft Word, which keyboard shortcut will allow you to select
an entire paragraph without using the mouse?

A.  Ctrl + Shift + Right Arrow

B.  Ctrl + Shift + Down Arrow

C.  Ctrl + A

D.  Ctrl + Shift + Up Arrow

✓

Q77 Computer
Which command is used to arrange data alphabetically or
numerically in MS Excel 2021?

A.  Sort

B.  Arrange

C.  Align

D.  Filter

✓

Q78 Computer
To insert a video or audio in a slide, go to:

A.  Insert → Media

B.  Design → Layout

C.  Review → Add Clip

D.  View → Multimedia

✓

Q79 Computer
What is the difference between Reply and Forward in email
communication?

A.  Reply sends a message to a new recipient; Forward replies to
the sender.

B.  Reply responds to the original sender; Forward sends the
message to another recipient.

C.  Both send responses to everyone in the email thread.

D.  Forward deletes the original message automatically.
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✓

Q80 Computer

In context of using powerpoint (MS PowerPoint 2021), match the
Basic Functions in Column A with their correct descriptions in
Column B:

Column A Column B

1. Slide Show
Mode

a) Applies visual effects and transitions to slide
elements

2. Design Tab
b) Displays the presentation in full-screen view for
presentation purposes

3. Animations
Tab

c) Offers slide themes, background formats, and
color variations

4. Insert Tab
d) Enables adding content like images, charts,
shapes, and text boxes

A.  1–b, 2–c, 3–a, 4–d

B.  1–a, 2–d, 3–b, 4–c

C.  1–c, 2–b, 3–d, 4–a

D.  1–d, 2–a, 3–c, 4–b

✓

Q81 Computer
Which of the following is correct about the power saving mode on a
computer?

A.  Brightens the screen

B.  Clears the screen

C.  Sharpens the screen

D.  Dinges the screen

✓

Q82 Computer
Which of the following is considered system software, even though
it is not directly visible during normal computer use?

A.  Text editor

B.  Bootloader

C.  Spreadsheet

D.  Media player

✓

Q83 Computer
Which built-in Windows 11 feature enables users to revert system
files and settings to an earlier point in time?

A.  Disk Cleanup

B.  System Restore

C.  Task Scheduler

D.  Event Viewer

✓

Q84 Computer
In MS PowerPoint, which view allows a user to edit slide content,
rearrange slides, and apply animations while providing a
comprehensive overview of the entire presentation?

A.  Slide Sorter View

B.  Normal View

C.  Reading View

D.  Outline View

✓

Q85 Computer
What is the purpose of using the 'General' format in MS Excel?

A.  To display text only

B.  To apply currency formatting

C.  To select the default number format that Excel applies when
you type a number

D.  To display large numbers in scientific notation

✓

Q86 Computer
An e‑mail’s body is separated from its headers by what character
sequence?

A.  Single newline

B.  Double newline

C.  Semicolon

D.  Comma

✓

Q87 Computer
What was the original storage capacity of a standard CD (Compact
Disc)?

A.  650-700 MB

B.  1.44 MB

C.  4.7 GB

D.  100 MB

✓

Q88 Computer
How do you create a new blank document in MS Word?

A.  Home tab > New

B.  File tab > New > Blank Document

C.  Insert tab > New

D.  View tab > New
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✓

Q89 Computer
What is the shortcut key to delete characters to the left in MS Word?

A.  Delete

B.  Backspace

C.  Ctrl+Del

D.  Ctrl + Shift + Del

✓

Q90 Computer
What is the default name of a new Workbook before saving it in
Excel?

A.  Sheet1

B.  Book1

C.  Workbook1

D.  Newdocument

Reasoning

✓

Q91 Reasoning
A, B, C, D, E, F and G are sitting around a circular table, facing the
centre. A is sitting to the immediate right of B. D is sitting to the
immediate left of C. D is sitting to the immediate right of E. F is
sitting second to the right of B. G is sitting second to the left of A.

How many people in total are sitting between G and E when counted
from the right of G?2353

A.  1

B.  2

C.  3

D.  4

✓

Q92 Reasoning
Munna starts from Point A and drives 43 km towards North. He then
takes a right turn, drives 51 km, turns right and drives 52 km. He
then takes a right turn and drives 56 km. He takes a final right turn,
drives 9 km and stops at Point P. How far (shortest distance) and
towards which direction should he drive in order to reach Point A
again? (All turns are 90-degree turns only unless specified.)

A.  3 km to the east

B.  4 km to the west

C.  5 km to the east

D.  6 km to the west

✓

Q93 Reasoning
What will come in the place of ‘?’ in the following equation, if ‘+’ and ‘
– ‘ are interchanged and ‘×’ and ‘÷’ are interchanged?
88 + (56 × 8) ÷ 4 - 19 = ?

A.  68

B.  79

C.  84

D.  92

✓

Q94 Reasoning
Select the pair which follows the same pattern as that followed by
the two set of pairs given below. Both pairs follow the same pattern.
HQV : JUU
LPX : NTW

A.  PUR : RYQ

B.  FTH : HXF

C.  MVO : OYN

D.  WIJ : YMH
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✓

Q95 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?

KAC 14 IBE 1 GCG -12 EDI -25 ?

A.  CEK -38

B.  NJK -32

C.  GHT -67

D.  VFG -43

✓

Q96 Reasoning
Each of B, C, D, E, G, H and I has flight on a different day of a week
starting from Monday and ending on Sunday of the same week.
Only B has flight before D. Only three people have flight between E
and H. G has flight on some day before H and on some day after I.
Only three people have flight between C and D. How many people
have flight after E?

A.  Four

B.  Three

C.  Two

D.  One

✓

Q97 Reasoning
In a certain code language,
A @ B means ‘A is the father of B’
A & B means ‘A is the wife of B’
A # B means ‘A is the son of B’
A % B means ‘A is the mother of B’

Based on the above, how is P related to T if ‘P # Q % R & S @ T’?

A.  Father’s father

B.  Wife’s father

C.  Mother’s brother

D.  Mother’s father

✓

Q98 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: Some machines are anchors. Some anchors are wheels.
Conclusion (I): Some machines are wheels.
Conclusion (II): All wheels are anchors.

A.  Neither conclusion (I) nor (II) follows

B.  Both conclusions (I) and (II) follow

C.  Only conclusion (II) follows

D.  Only conclusion (I) follows

✓

Q99 Reasoning
Based on the alphabetical order three of the following four letter
clusters are alike in a certain way and thus form a group. Which is
the one that does not belong to that group? (Note: The odd man out
is not based on the number of consonants/vowels or their position
in the letter cluster)3495

A.  XRD-ONC

B.  QSF-HQE

C.  LHY-CDX

D.  VPL-MLK

✓

Q100 Reasoning
Refer to the following series and answer the question (All numbers
are single-digit numbers only) (Counting to be done from left to
right only)
(Left) 5 8 1 6 9 3 4 2 5 6 7 4 9 8 3 5 1 7 8 (Right)
How many such perfect squares are there, each of which is
immediately preceded by an odd digit and also immediately
followed by a prime digit?

A.  1

B.  2

C.  3

D.  4
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